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Welcome to KOMPLETE KONTROL
Where to Start?

1 Welcome to KOMPLETE KONTROL

Thank you for choosing KOMPLETE KONTROL!

KOMPLETE KONTROL and its dedicated keyboard—the KOMPLETE KONTROL S-SERIES—is
a tightly integrated music production studio that gives you absolute control over the instru-
ments in your KOMPLETE library.

KOMPLETE KONTROL lets you browse your KOMPLETE instruments in an intuitive way and
play them according to a vast amount of selectable scales and chords. You can also control
your host software with the KOMPLETE KONTROL S-SERIES keyboard, and customize the
functions of the touch strips, knobs and buttons according to your needs utilizing the included
Controller Editor application. We hope you enjoy this fantastic instrument as much as we do.
Now let’s get going!

—The team at Native Instruments

1.1 Where to Start?

KOMPLETE KONTROL provides you with many information sources. The main documents are
meant to be read in the following sequence:

1. Komplete Kontrol Setup Guide
2. Komplete Kontrol Manual (this document)

The whole documentation set is available in PDF format and located within the KOM-
PLETE KONTROL installation folder on your hard disk. You can also access these docu-
ments from the Help menu in the Application Menu Bar or from the Help submenu in the
KOMPLETE KONTROL menu.

Please check the Service Center or the Native Instruments website regularly for up-to-date
and localized versions of these documents. You can start the Service Center by selecting
Launch Service Center from the Help menu in the Application Menu Bar or from the Help
submenu in the KOMPLETE KONTROL menu.
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Please check the Service Center or the Native Instruments website regularly for up-to-date
and localized versions of these documents. You can start the Service Center by selecting
Launch Service Center from the Help menu in the Application Menu Bar or from the Help
submenu in the KOMPLETE KONTROL S-SERIES menu.

Additional documentation sources provide you with details on more specific topics:
= KOMPLETE KONTROL S-SERIES Ableton Live Setup document
= Controller Editor Manual

Hereafter is a quick description of each of these documentation sources.

Your First Stop: the Setup Guide

The Setup Guide will guide you through the software and hardware installation of KOM-
PLETE KONTROL and KOMPLETE KONTROL S-SERIES, from the very beginning to the first
sound coming through your speakers.

First read the Setup Guide. After reading the Setup Guide and following its instructions, KOM-
PLETE KONTROL and your KOMPLETE KONTROL S-SERIES keyboard should be up and run-
ning. Then proceed with this Komplete Kontrol Manual to get more familiar with KOM-
PLETE KONTROL.

Komplete Kontrol Manual

This Komplete Kontrol Manual provides you with a comprehensive description of all KOM-
PLETE KONTROL software and KOMPLETE KONTROL S-SERIES hardware features.

KOMPLETE KONTROL S-SERIES Ableton Live Setup

To get the most of your KOMPLETE KONTROL S-SERIES when using it to control your host
software, ensure you are running a compatible version of the host. To enable combined use of
Ableton Live and KOMPLETE KONTROL S-SERIES, Ableton Live 9.1.4 is required. In addition
to this, further configuration is necessary. A detailed guide for setting up Ableton Live for use
with KOMPLETE KONTROL S-SERIES is available as a PDF file in the Host Integration Files
subfolder of the Komplete Kontrol installation folder on your hard disk. It can also be found
here: http://www.native-instruments.com/en/support/knowledge-base/show/2643/
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Controller Editor Manual

Besides using your KOMPLETE KONTROL S-SERIES keyboard together with its dedicated
KOMPLETE KONTROL software, you can also use it as a powerful and highly versatile MIDI
controller to pilot any other MIDI-capable application or device. This is made possible by the
Controller Editor software, a little application that allows you to precisely define all MIDI as-
signments for your KOMPLETE KONTROL S-SERIES keyboard. The Controller Editor should
have been installed during the KOMPLETE KONTROL installation procedure. For more infor-
mation on this, please refer to the Controller Editor Manual available as a PDF file in the Docu-
mentation subfolder of the Controller Editor installation folder on your hard disk.

Other Online Resources

If you are experiencing problems related to your Native Instruments product that the supplied
documentation does not cover, there are several ways of getting help:

= Knowledge Base

= User Forum

= Technical Support

= Registration Support

You will find more information on these in chapter 19, Troubleshooting — Getting Help.

1.2 Manual Conventions

This section introduces you to the signage and text highlighting used in this manual. This man-
ual uses particular formatting to point out special facts and to warn you of potential issues.
The icons introducing these notes let you see what kind of information is to be expected:

Whenever this exclamation mark icon appears, you should read the corresponding note
carefully and follow the instructions and hints given there if applicable.

This light bulb icon indicates that a note contains useful extra information. This informa-
tion may often help you to solve a task more efficiently, but does not necessarily apply to

the setup or operating system you are using; however, it's always worth a look.

Furthermore, the following formatting is used:
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= Text appearing in (drop-down) menus (such as Open..., Save as... etc.) and paths to loca-
tions on your hard disk or other storage devices is printed in jtalics.

= Text appearing elsewhere (labels of buttons, controls, text next to checkboxes etc.) is
printed in blue. Whenever you see this formatting applied, you will find the same text ap-
pearing somewhere on the screen.

= Text appearing on displays of the keyboard is printed in light grey. Whenever you see this
formatting applied, you will find the same text on a controller display.

= Text appearing on labels of the keyboard is printed in . Whenever you see this for-
matting applied, you will find the same text on the controller.

= Important names and concepts are printed in bold.

= References to keys on your computer’s keyboard you’ll find put in square brackets (e.g.,
“Press [Shift] + [Enter]”).

» Single instructions are introduced by this play button type arrow.

— Results of actions are introduced by this smaller arrow.

Naming Convention

Throughout the documentation we will refer to KOMPLETE KONTROL S-SERIES as the keyboard
and KOMPLETE KONTROL as the software installed on your computer.

Button Combinations and Shortcuts on Your Keyboard

Most instructions will use the “+” sign to indicate buttons that must be pressed simultaneous-
ly, starting with the button indicated first. E.g., an instruction such as:

“Press + " means:

1. Press and hold

2. While holding , press and release it.
3. Release

Unlabeled Knobs on the KOMPLETE KONTROL S-SERIES Keyboard

The knobs above the displays on your KOMPLETE KONTROL S-SERIES keyboard do not have
labels.
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The unlabeled knobs on the KOMPLETE KONTROL S-SERIES keyboard

For better reference, we applied a special formatting here: throughout the document, the ele-
ments are capitalized and numbered, so the knobs above the displays are written Knob 1 to
Knob 8. E.g., whenever you see an instruction such as “Turn Knob 2 to increase the value,”
you'll know it's the second knob from the left above the displays.

1.3  System Requirements
For KOMPLETE KONTROL and KOMPLETE KONTROL S-SERIES to fully function as indented,
your system needs to meet the following requirements.

= Windows 7 or Windows 8

= Mac OS X 10.8 or 10.9

= USB 2.0 or higher for KOMPLETE KONTROL S-SERIES (cable included)

= Power supply for KOMPLETE KONTROL S-SERIES (adapter included)

KOMPLETE

KOMPLETE KONTROL is optimized for use with KOMPLETE 10 and KOMPLETE 10 ULTI-
MATE. For full features set, KOMPLETE 9 or higher is required. System requirements for KOM-
PLETE 10 and KOMPLETE 10 ULTIMATE:

= Windows 7 or Windows 8, Intel Core 2 Duo or AMD Athlon 64 X2
= Mac OS X 10.7, 10.8 or 10.9, Intel Core 2 Duo
= 4 GB RAM (6 GB recommended for large KONTAKT instruments)
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Supported Host Applications

For some of the advanced host integration features of KOMPLETE KONTROL to function as in-
tended, your host application must be compatible. The following Knowledge Base article gives
you an overview of the features that are available in each of the most commonly used DAWs:

http://www.native-instruments.com/en/support/knowledge-base/show/2765/

For the latest information on KOMPLETE KONTROL compatibility with third-party software,
visit: www.native-instruments.com/komplete-kontrol-system-requirements
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2 Basic Concepts

This chapter will introduce you to KOMPLETE KONTROL's main elements and explain how
they relate to one another. You will also learn how to set up your audio interface and how to
connect MIDI devices.

Before reading this chapter it is strongly recommended that you read the KOMPLETE KON-
TROL Setup Guide.

2.1 KOMPLETE KONTROL and KOMPLETE KONTROL S-SERIES

KOMPLETE KONTROL is the combination of the KOMPLETE KONTROL software with its quick
browsing experience and powerful performance abilities, and the versatile KOMPLETE KON-
TROL S-SERIES keyboard’s tactility—both fully integrated with the instruments of Native In-
struments KOMPLETE.

KOMPLETE KONTROL and each area of its software interface correspond directly to the hard-
ware sections of your KOMPLETE KONTROL S-SERIES keyboard. Adjusting instrument param-
eters from the knobs on your keyboard also adjusts the corresponding controls in the software.
You can see the software controls move in real-time whenever you turn your hardware knobs,
swipe the touch strips, or switch button states on and off.

Via KOMPLETE KONTROLS’s browser you can load any KOMPLETE instrument and even
search for specific types of sounds and presets, e.g. “soundscapes” or “percussion.”

When you load a KOMPLETE instrument inside KOMPLETE KONTROL, you instantly get ac-
cess to the instrument’s controls from the KOMPLETE KONTROL S-SERIES keyboard. The
knobs, displays, and touch strips on the keyboard are automatically mapped to the parameters
of the loaded KOMPLETE instrument via Native Instruments’ own unique Native Map protocol.

KOMPLETE KONTROL’s Perform Panel lets you generate and play back a multitude of scales,
chords, and arpeggios simply by pressing a key on your KOMPLETE KONTROL S-SERIES key-
board. By mapping the keyboard’s keys to a scale, you can ensure that you’ll always stay in key
as well as learn to play new and interesting types of music.
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The LEDs in the Light Guide give you visual feedback in real time, letting you know what keys
are active and which notes are being played back. You can even follow the Light Guide when
you are playing back a MIDI note pattern from a host application.

= For an overview of how KOMPLETE KONTROL and KOMPLETE KONTROL S-SERIES inte-
grate with each other, continue reading below.

= For a quick start to get you going with KOMPLETE KONTROL S-SERIES, see chapter 13,
Quick Start.

= For a detailed description of the KOMPLETE KONTROL software, see chapter 14, KOM-
PLETE KONTROL Software Overview and onward.

= For a detailed description of the KOMPLETE KONTROL S-SERIES keyboard, see chapter
17, KOMPLETE KONTROL S-SERIES Keyboard and onward.

Corresponding Features

In the following sections we outline the KOMPLETE KONTROL software and the KOM-
PLETE KONTROL S-SERIES keyboard and give you an overview of how they relate to each oth-
er and to the instruments in your KOMPLETE library.

2.1.1  The Browser and the Navigate Section

The browser is where you access your KOMPLETE library with all its instruments. You can
search, edit, tag, arrange, and load your files from the KOMPLETE KONTROL software, but al-
so use the section on your KOMPLETE KONTROL S-SERIES keyboard to call up an
on-screen overlay displaying the browser. This way you can also search, filter, and load your
KOMPLETE instruments using only the hardware controls, which is great e.g. for live perform-
ance situations.
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©KOMPLETE KONTROL
Library
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All Instruments
MONARK

TUNING. OSCILLATOR 1
ocrave RANGE  FREQUENCY  WAVEFOS
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® KOMPLETE KONTROL
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ALLINSTRUMENTS.

® KOMPLETE KONTROL 25

T e—
[ e ]

The browser at the left side of the KOMPLETE KONTROL software interface and the browser displayed by the on-screen
overlay, called up from the section of the KOMPLETE KONTROL S-SERIES keyboard (S25 depicted).

2.1.2  The Perform Panel and the Perform Section

The Perform Panel near the top of the KOMPLETE KONTROL software interface gives you con-
trols for generating scales and chords, and playing arpeggios using your KOMPLETE instru-
ments as sound source. The same parameters can also be accessed from the sec-
tion in the upper left corner of your KOMPLETE KONTROL S-SERIES keyboard. The perform
parameters are then mapped to the knobs and the displays on the keyboard, letting you edit
the scales and arps using the hardware controls.
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® KOMPLETE KONTROL
Library

a

All Instruments

MONARK

OSCILLATOR 2

WAIGATE

TRANSPOSE

The Perform Panel in the KOMPLETE KONTROL software with the corresponding controls of KOMPLETE KONTROL S-SER-
IES’ PERFORM section mapped to the knobs and displays

2.1.3  The Light Guide

The settings of the perform parameters are instantly reflected by the LEDs of the Light Guide—
located just above the keybed—effectively letting you know what keys belong to the scale se-
lected in the Perform Panel (software) or section (keyboard) by switching the LEDs
on and off. When you press an unlit key, KOMPLETE KONTROL will instead play back the
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nearest lit key, ensuring you are always in key and within the scale. The Light Guide also gives
you visual feedback when you play back incoming MIDI note patterns from your host sequenc-
er.

© KOMPLETE KONTROL
Library

All Instruments
MONARK —

TUNING OSCILLATOR 1 FILTER
RS

ocTave FINE RANGE  FREQUENCY WAVEFORM  VOLUME s cutorr contour
o I3 g

i o || S
e

FEEDBACK
S
OSCILLATOR 2

AmACK

® KOMPLETE KONTROL 25

PERFORM o or HAVIGATE

L] B

TRANSPORY

TRANSPOSE

The Light Guide reflects the settings of the perform parameters by switching the LEDs on or off to display the selected scale
(C major).
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2.1.4  The Control Section and KOMPLETE Instrument Parameters

The touch strips, knobs, and displays on the KOMPLETE KONTROL S-SERIES keyboard are
automatically mapped to the controls and parameters of any loaded KOMPLETE instrument via
Native Instruments’ unique integration mapping protocol Native Map. No further MIDI assign-
ments are necessary: Just load an instrument from the browser and start playing!

© KOMPLETE KONTROL
Library

All Instruments

MONARK

TUNING OSCILLATOR 1
FNE FREQUENCY Wi

OSCILLATOR 2

WAVIGATE

oo
[
= (-
(K] =

MONARK loaded in KOMPLETE KONTROL—the touch strips, knobs, and displays on KOMPLETE KONTROL S-SERIES are
automatically assigned to control the instrument.
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2.1.5  The Transport Section and Your Host Application

Controlling your host application from the KOMPLETE KONTROL S-SERIES keyboard is a great
way to keep your workflow going without needing to grab for the computer mouse and can be
very helpful in live performance situations. The section on the far left and the ar-
row buttons in the section on the right are both used to select and record arm
tracks in your DAW, so you can play and record notes from your keyboard. For detailed infor-
mation on how controlling your host from the KOMPLETE KONTROL S-SERIES, see section
17.3, Host Control and the Transport Section.

@ KOMPLETE KONTROL 25

PERFORM o o

The TRANSPORT section and the NAVIGATE buttons let you control your host application from the KOMPLETE KON-
TROL S-SERIES.

For information on how to configure your host application for use with external MIDI hard-
ware, refer to the documentation of your DAW.
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2.2 Adjusting the KOMPLETE KONTROL Software Interface

The KOMPLETE KONTROL software user interface is very flexible. You can choose what to dis-
play and what not, allowing you to focus on your workflow. This section shows you how to ad-
just the KOMPLETE KONTROL GUI to suit your needs.

2.2.1  Showing/Hiding the Browser

» Click the browser button (with the magnifier symbol) in the header to show and hide the
browser. You can also select Browser from the View menu in the application menu bar or
from the View submenu in the KOMPLETE KONTROL menu.

@ KOMPLETE KONTROL
Library

iy

The browser button in the header

In stand-alone mode, you can also show/hide the browser from your computer keyboard via
the [B] key.

2.2.2  Showing/Hiding the Perform Panel

» Click the Perform Panel button (with the three-notes symbol) in the header to show and
hide the Perform Panel. You can also select Perform Panel from the View menu in the
application menu bar or from the View submenu in the KOMPLETE KONTROL menu.
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o IR 4

O Scale O

Major Standard

The Perform Panel button in the header

In stand-alone mode, you can also show/hide the Perform Panel from your computer key-

board via the [P] key.

2.2.3  Selecting Instrument Views

Once you have loaded a KOMPLETE instrument from the browser, it appears in the instrument
area of the KOMPLETE KONTROL software. Most instruments come equipped with more than
one view, giving you access to another set of controls or letting you edit certain features in fi-

ner detail. The three possible instrument views are described below.

» To switch between the instrument views, click View in the application menu bar or the
View submenu of the KOMPLETE KONTROL menu and select Default View, Additional

View, or Edit View.

File Edit [View] Contreller Help Developer

Browser B
Browser

Perfarm Panel

Perform Panel

Ctrl+1
Ctrl+2
Ctrl+3

Default View
Additional View
Edit View

Default View

Additional View
Edit View

Instrument views in the View menu of the application menu bar (Windows depicted), and in the View submenu of the KOM-

PLETE KONTROL menu.

The available views may vary with the loaded instrument.
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All instrument parameters can be controlled at all time from the KOMPLETE KONTROL S-
SERIES keyboard, regardless of the selected instrument view in the KOMPLETE KONTROL
software.

Default View

The default view is the view that first appears when you load an instrument from the browser.
It gives you access to some of the most important features of each KOMPLETE instrument with
an easy-to-use interface.

£ | v Basshunter 43 W 120.00 o [In

pDLK)pLEX VEL: 100 TUNE:D DEC:100  VOL: -48dB

SOUND1 VOLUME +3dB BALANCE O DECAY 100

POLYPLEX in default view

Additional View

Most KOMPLETE instruments have more parameters than can be displayed at once in small
surface and therefore come with a second, additional view. The additional view can give you
access to detailed edit controls or to a completely different set of controls altogether depend-
ing on the loaded instrument.
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ol v Basshunter 43 W 120.00
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SOUND1 VOLUME +3dB BALANCE O TUNE 0O DECAY 100

SETTINGS SUBTYPE SAMPLES VOLUME
4 > ACOUSTIC O

<> DIGITAL 1

P OT 2 SFX [l
4 > K|

sue —

-] - s B

SPREAD |
WAVE FREQ BEND AlR

AMOUNT

SELECT

POLYPLEX in additional view

» To switch to the additional view, click the + button in the KOMPLETE KONTROL header.

HOLVPLEX

Clicking it again will return the KOMPLETE instrument to default view.
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Edit View

You also have the possibility to open any KOMPLETE instrument that can be loaded and
played by either the KONTAKT or REAKTOR players in edit view. Use the edit view to access
all the flexible controls and features you would normally have when using KONTAKT or REAK-
TOR in stand-alone mode.

» To switch to the edit view, click Edit View in the View submenu of the KOMPLETE KON-
TROL menu.

Basshunter

Perfarm Panel

Default View
Additional View
Edit View

Edit view is only available for instruments powered by KONTAKT or REAKTOR.

Edit view enables you to access files that cannot be loaded from the KOMPLETE KONTROL
browser, e.g. KONTAKT Multis which can be loaded from the KONTAKT browser in edit
view.
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POLYPLEX in edit view

2.3  Stand-Alone and Plug-in Mode

You can run the KOMPLETE KONTROL software as a stand-alone application or integrate it in-
to your favorite Digital Audio Workstation (or DAW, in short) by loading it as a plug-in. The
KOMPLETE KONTROL software is available in the VST, Audio Unit, and AAX plug-in formats.
For further information on plug-in compatibility and for a detailed description of how to use
plug-ins in your host, please refer to the documentation included with your host software. If
you did not install the plug-ins when installing the KOMPLETE KONTROL software, please re-
fer to the Setup Guide available from the documentation folder in the KOMPLETE KONTROL
software installation folder.
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You cannot record MIDI in stand-alone mode. For information on audio and MIDI routing,
see section 12.6, Audio and MIDI Settings.

For information on how to load KOMPLETE KONTROL as a VST, AAX or AU plug-in, refer to
the documentation of your host application.

2.3.1 Differences between Stand-Alone and Plug-in Mode

Transport Functions and Navigate Controls

When KOMPLETE KONTROL is used as a plug-in within a host sequencer software (e.g., Cu-
base or Pro Tools), the transport functions and the navigate controls on the KOMPLETE KON-
TROL S-SERIES keyboard can be used to control your host application. For example, you can
switch tracks in your DAW, record arm them, and play back your recordings, all from your key-
board. For more information, see section 17.3, Host Control and the Transport Section.

When using KOMPLETE KONTROL S-SERIES in MIDI mode, you can do this even when no
instance of KOMPLETE KONTROL is running.

When KOMPLETE KONTROL is used as a plug-in within a host sequencer software (e.g., Cu-
base or Logic), KOMPLETE KONTROL receives its MIDI clock exclusively from the host appli-
cation: you cannot modify the tempo of your host project within the KOMPLETE KONTROL
plug-in itself—it is synchronized to your host’s transport functions and tempo settings. As a di-
rect consequence, when KOMPLETE KONTROL is used as a plug-in the tempo field is grayed
out and inactive in the KOMPLETE KONTROL header.

Audio and MIDI Handling

When KOMPLETE KONTROL is used in stand-alone mode, it directly communicates with your
audio and MIDI interface. You can select which physical audio/MIDI ports have to be used on
your interface, and configure crucial audio settings like the sample rate. All this is done via the
Audio and MIDI Settings panel (for more information on this, please refer to 12.6, Audio and
MIDI Settings).

= On the contrary, when KOMPLETE KONTROL is used as a plug-in within a host applica-
tion, the communication with your audio and MIDI interfaces is managed by the host—
the KOMPLETE KONTROL plug-in only communicates with the host.
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For all details on the audio and MIDI configuration of your host application, please refer to
its documentation.

Multiple Plug-in Instances

When you are using KOMPLETE KONTROL as a plug-in within a host application, you can
open multiple KOMPLETE KONTROL instances. Actually, you can load as many instances of
KOMPLETE KONTROL as your computer and your host application can handle CPU-wise. In
contrast to the stand-alone application, they are always tempo synced to the host. In plug-in
mode you can also record automation for KOMPLETE KONTROL or KOMPLETE instrument pa-
rameters from your host. To learn more, have a look at chapter 12.10, Controlling Parameters
via MIDI and Host Automation and 17.3.3, Switching between KOMPLETE KONTROL Instan-
ces.

2.3.2  Switching Instances

When two or more instances of the KOMPLETE KONTROL software are running (e.g., as plug-
ins on different tracks of your DAW), you must choose which instance you want to control from
your KOMPLETE KONTROL S-SERIES keyboard. You can do this both from your keyboard and
in the software.

a3 Il 120.00

Click the Connect button to connect the keyboard to that instance.

Switching Instance from the Software

» To select your keyboard from a particular KOMPLETE KONTROL instance, click the Con-
nect button (keyboard icon) in the KOMPLETE KONTROL header of that instance.

Switching Instance from the Keyboard
To select a particular KOMPLETE KONTROL instance from your keyboard:

Depending on the compatibility and version number of your host application, switching be-
tween instances of KOMPLETE KONTROL may not function as described.
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For use of KOMPLETE KONTROL S-SERIES with Ableton Live, refer to the KOM-
PLETE KONTROL S-SERIES Ableton Live Setup document available as a PDF file in the
Host Integration Files subfolder of the Komplete Kontrol installation folder on your hard
disk.

» Toselect a KOMPLETE KONTROL instance from your keyboard, use the up
and down buttons on your KOMPLETE KONTROL S-SERIES to select the track contain-
ing the instance in your DAW. The KOMPLETE KONTROL instance loaded on that track is
automatically selected.

For detailed information about selecting tracks and KOMPLETE KONTROL instances from your
keyboard, see section 17.3, Host Control and the Transport Section.

2.3.3  Configuring Your Host Application

Though KOMPLETE KONTROL can be used stand-alone, most of the time you will want to load
it as a plug-in in a host application. Before using the KOMPLETE KONTROL S-SERIES key-
board to control your host application, there are a few things to be aware of. To learn more
about the necessary configuration steps, continue reading below.

For detailed information on how to set up your DAW for fully integrated use with KOM-
PLETE KONTROL and KOMPLETE KONTROL S-SERIES, refer to the documentation of
your host application.

Configuring Your Host for Use with KOMPLETE KONTROL S-SERIES

For some of KOMPLETE KONTROL’s most advanced host integration features to function as
intended, your host application must support these features. For an overview of which host in-
tegration features that are supported by which host applications, refer to the following Knowl-
edge Base article: http://www.native-instruments.com/support/knowledge-base/show/2765/.

At the time of writing this manual, the following DAWs support full functionality of KOM-
PLETE KONTROL S-SERIES:

= Ableton Live 9.1.4 (further configuration required, see Knowledge Base article below)
= Apple Logic X 10.0.7

= Steinberg Cubase 7.5.1

= Steinberg Nuendo 6.0.7
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For information on how to configure your host application for use with external MIDI hard-
ware, refer to the documentation of your DAW.

For detailed guides to help to you set up and configure your host application for use with KOM-
PLETE KONTROL S-SERIES, refer to these Knowledge Base articles:

= Setting up Ableton Live for KOMPLETE KONTROL:
http://www.native-instruments.com/support/knowledge-base/show/264 3/

= Setting up Apple Logic for KOMPLETE KONTROL:
http://www.native-instruments.com/support/knowledge-base/show/2787/

= Setting up Steinberg Cubase / Nuendo for KOMPLETE KONTROL:
http://www.native-instruments.com/support/knowledge-base/show/2785/

Compatibility with Other Connected MCU Devices

If you have other MIDI devices using the MCU (Mackie Control Universal) protocol in your
setup, then connecting and configuring the KOMPLETE KONTROL S-SERIES in your host
can cause interference between the devices.

Depending on the host application of your choice, the following measures can be taken to
avoid interference with other connected MCU devices. If you are using one of the supported
hosts (as listed above):

» To keep all KOMPLETE KONTROL S-SERIES’ features intact except host integration fea-
tures (i.e. host transport controls and automatic track focus) ensure you do not set up
KOMPLETE KONTROL S-SERIES as an MCU control surface when configuring your host
application. Doing so will allow you to use other MCU devices simultaneously.

» To keep all KOMPLETE KONTROL S-SERIES’ features intact—including host integration
features (i.e. host transport controls and automatic track focus)—set up KOM-
PLETE KONTROL S-SERIES as an MCU control surface when configuring your host appli-
cation. Doing so will however not allow you to use other MCU devices simultaneously.

For a detailed guide on using KOMPLETE KONTROL S-SERIES with other MCU devices,
refer to the following Knowledge Base article: http://www.native-instruments.com/support/
knowledge-base/show/2895/
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24  MIDI Mode

Besides using your KOMPLETE KONTROL S-SERIES keyboard together with its dedicated
KOMPLETE KONTROL software, you can also use it as a powerful and highly versatile MIDI
controller to pilot any other MIDI-capable software application running on the computer it is
connected to via USB as well as any other MIDI-compatible hardware.

The MIDI ports on KOMPLETE KONTROL S-SERIES’ rear panel are only active when the
keyboard is connected to your computer via USB.

Switching to MIDI Mode

To switch your keyboard between KOMPLETE KONTROL mode and MIDI mode:

Switching to MIDI mode via the INSTANCE button is only possible in stand-alone mode.

Controller Editor

The versatility of the MIDI mode is made possible by the Controller Editor software, an applica-
tion that allows you to precisely define all MIDI assignments for your KOMPLETE KONTROL S-
SERIES keyboard. The Controller Editor is installed during the KOMPLETE KONTROL installa-
tion procedure. For more information on this, please refer to the Controller Editor Manual avail-
able as a PDF file in the Documentation subfolder of the Controller Editor installation folder on
your hard disk.

2.5 Preferences

The Preferences panel lets you specify various settings for KOMPLETE KONTROL.

» To open the Preferences panel, click Preferences... in the Komplete Kontrol menu (Mac
0OS X) or Edit menu (Windows) of the application menu bar, or in the Edit submenu of the
KOMPLETE KONTROL menu:

The following pages are available in the Preferences panel:

= Library: see 12.5.1, Preferences — Library Page.

KOMPLETE KONTROL - Manual - 34



Basic Concepts

Preferences
= Hardware: see 12.5.2, Preferences — Hardware Page.

2.5.1 Preferences — Library Page

The Library page allows you to edit the locations of all KOMPLETE KONTROL library files (both
factory and user) that appear in the Library pane of the Browser.

The Library pane of the Browser is described in section 15.2, Searching and Loading Files
from the Library.

» To display the Library page click the Library tab on the left of the Preferences panel.

At the top of the page, the Factory and User buttons allow you to switch between the Factory
pane and the User pane.

Factory Pane

» To display the Factory pane, click the Factory button at the top of the Library page.
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Preferences

- Factory

Location
rary
Library

Library

Rescan

The Preferences panel — the Library page’s Factory pane.

The Factory pane shows all factory libraries available. These libraries will appear in the Factory
view of the Browser’s Library pane.

Element Description

[Location column Shows the path of each library. If you have moved any library to another location
on your computer, click the folder icon on the left of that library and select its
new path.

Product column Shows the name of each product. These names cannot be edited.

Rescan button If you have made any change to a library (e.g., changed its location), select it in
the list and click the Rescan button to rescan that library.
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User Pane

» To display the User pane, click the User button at the top of the Library page.

Preferences

g Downloads az

e Kontrol

Rescan

Close

The Preferences panel — the Library page’s User pane.

The User pane shows all user libraries currently used. These include KOMPLETE KONTROL's
standard user directory as well as any other user directory you might have defined. These libra-
ries will appear in the User view of the Browser’s Library pane.
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Element Description

[Location column

Shows the path of each library. If you have moved any library to another location
on your computer, click the folder icon on the left of that library and select its
new path.

Alias column

Shows the alias stored for each library. Click an alias to edit it. Defining aliases
for your user folders is not mandatory, but it can be of great help when working
on different computers (see description below). After adding a location (see Add
below), click the field in the new row and in the Alias column to set the alias for
that new location. The alias of the default user folder, Native Instruments User
Directory, cannot be edited — this is the location where all your user files will be
stored by default.

Add button

Click Add to manually add directories to the user library. See below for more de-
tails.

Remove button

Click Remove to remove the selected user library. Files will only be removed
from the KOMPLETE KONTROL Browser, not from your hard disk.

Rescan button

If you have made any change to a library (e.g., added/removed files), select it in
the list and click the Rescan button to rescan that library.

You can resize the Preferences panel at your convenience using the usual method on your
operating system. You can also resize each column by clicking and dragging the limit be-
tween both column headers.

Adding Folders to the User Library

In the User pane of the Library page, you can add other folders to the user content of your

KOMPLETE KONTROL library. To do this:

1. Click Add at the bottom of the pane.
A folder selection dialog opens up.

2. In the dialog, navigate to the desired folder on your computer and click OK (Choose on
Mac OS X).

— All KOMPLETE KONTROL-compatible files found in the selected folder are added to your
user content in KOMPLETE KONTROL.

KOMPLETE KONTROL-compatible files include ens, rkplr, nrkt, nfm8, nabs, nki, nmsv,

and nbkt.
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Furthermore, the attributes (product/bank/sub-bank, type/subtype/mode tags, as well as proper-
ties) of all imported files will be retained.

By adding a folder to the user content of your KOMPLETE Library, you make their files availa-
ble in the Browser’'s Library pane for quick searching and loading! For more information on
how to use the Library pane of the Browser, please refer to section 15.2, Searching and Load-
ing Files from the Library.

Paths to folders added via the IMPORT button in the Browser’s Files pane will also show up
here. The only difference between adding folders via the Add button in Preferences panel,
described here, and via the IMPORT button in the Files pane of the Browser is that the lat-
ter allows you to directly tag the files as they are imported. See section 15.5.5, Using the
Result List for more information on how to import folders via the Files pane.

Please note that the selected folder cannot contain, or be contained within, a folder already
listed in the User or Factory pane. If KOMPLETE KONTROL detects such a folder as you press
OK (Choose on Mac OS X) in the folder selection dialog, a Duplicate Location message ap-
pears: Click OK to return to the folder selection dialog and select another folder on your com-
puter.

Removing Folders from the User Library

You can also remove any user folder from your library—except the default user content directo-
ry Native Instruments User Content.

2.5.2 Preferences — Hardware Page

The Hardware page enables you to customize how the keys react to your playing and to adjust
the behavior of the touch strips, as well as switch the Light Guide on or off.

» To display the Hardware page click the Hardware tab on the left of the Preferences panel.
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Preferences

Keyboard

Valocity ! limg Linaar
Hardware
Light Guide

Enabled
Pitch Strip
Spring Strengtl
Modulation Strip

Maode

Closa

The Preferences panel — Hardware page, Standard mode.
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Preferences

Keyboard

Velocity Scaling Linear
Light Guide

Enabled

Pitch Strip

Spring Strengtl

Modulation Strip

Closa

The Preference panel — Hardware page, Ball mode.

Setting Description

Keyboard

Velocity Scaling

get a big velocity value).

Velocity Scaling determines how your playing is translated into velocity val-
ues: starting from Soft 3 (a soft touch is enough to get a big velocity value)
through Linear (default) to Hard 3 (you really have to press the key hard to

Light Guide

Enabled

Perform Panel.

Light Guide allows you to switch the colored LEDs above the keybed on or
off. The Light Guide visualizes MIDI patterns being played back from your
host application as well as shows you the active keys in any scale from the
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Preferences

Setting Description

Pitch Strip

Spring Strength

Spring Strength affects how fast the pitch strip snaps back to its default
value upon release: from very slow (fully left) to instantly (fully right).

Modulation Strip

Mode

Mode lets you select one of two behaviors for the modulation strip: Stand-
ard or Ball. In Standard mode, the value of modulation strip only changes
when you touch it. In Ball mode, the modulation strip behaves like a physi-
cal object in space (e.g. a ball) and you can further define the behavior us-
ing the three extra parameters Friction, Gravity, and Walls.

Display

Display lets you select one of two ways to display the current state of the
modulation strip: Bar or Dot. Bar displays a bar of LEDs from the bottom of
the strip to the current value (similar to a level meter); whereas Dot dis-
plays only the current value.

Friction (Ball mode only)

Friction determines how fast the virtual ball decelerates and stops once
you release the strip: from never stops (fully left) to stops instantly (fully
right).

Gravity (Ball mode only)

Gravity determines how fast the virtual ball gravitates toward your finger, if
you touch the strip again while the ball is still “bouncing.”

Walls (Ball mode only)

Walls determines whether the virtual ball bounces off the edges of the strip
or wraps around it.

For more information on the Light Guide, see section 17.7, The Light Guide.

For more information on the touch strips, see section 17.6, Touch Strips.

For information on the MIDI mode, please refer to the Controller Editor Manual.
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2.6  Audio and MIDI Settings

When KOMPLETE KONTROL is running as a stand-alone application, the Audio and MIDI Set-
tings panel allows you to configure the audio and MIDI hardware device(s) to use with KOM-
PLETE KONTROL along with the audio routing between your audio device and KOM-
PLETE KONTROL.

» Toopen the Audio and MIDI Settings panel, select the Audio and MIDI Settings... entry
from the Edit menu in the application menu bar (or from the Edit submenu in the KOM-
PLETE KONTROL menu).

When KOMPLETE KONTROL is running as a plug-in in a host application, its audio and
MIDI configuration is managed by the host, and the Audio and MIDI Settings panel is not
available. See section 12.3, Stand-Alone and Plug-in Mode for more information on using
KOMPLETE KONTROL in a host environment.

The Audio and MIDI Settings panel contains three pages: Audio, Routing, and MIDI. Each
page can be displayed by clicking the corresponding tab at the top.

2.6.1  Audio and MIDI Settings — Audio Page

The Audio page holds settings related to your audio interface.

KOMPLETE KONTROL - Manual - 43



Basic Concepts
Audio and MIDI Settings

rAudiu and MIDI Settings §1

Audio Routing MIDI (o
Driver (asio -]
Device [ ASI0 Config | [ Komplete Audio 6 -]
Status [ Running |
Sample Rate (44100 -]
Latency &4 Samples
Input ! Processing » 1.5ms | Output» 4.4 ms | Overall » 5.9 ms

[ © Cancel J L @ OK J

The Audio page of the Audio and MIDI Settings panel.

Setting Description

Driver Select your audio driver here.

Device This allows you to choose from the available devices if you have connected
more than one audio interface.

Status This shows you whether your audio interface is currently running.
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Setting Description

Sample Rate This displays the selected sample rate of your audio interface. Please re-
start KOMPLETE KONTROL after changing the sample rate.

Latency Mac 0S X: This slider allows you to adjust the latency of your audio inter-
face in samples. Lower values result in a more immediate playing response
but are heavier on both the CPU and the audio driver, and may result in
audible clicks and pops. Larger values are easier on the CPU, but intro-
duce a larger latency (i.e., there may be a very small delay between when
you hit a pad and when you actually hear it). You should therefore experi-
ment with this setting so that it is as low as possible without overloading
your CPU or introducing any audio artifacts.

Windows: When using an ASIO driver, the Audio and MIDI Settings panel
shows an ASIO Config button instead of the Latency slider. Click this but-
ton to open the settings window of the selected ASIO driver.

2.6.2  Audio and MIDI Settings — Routing Page

The Routing page allows you to configure the connections between the virtual outputs of KOM-
PLETE KONTROL and the physical outputs of your audio interface.
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F B
Audio and MIDI Settings (|
Audio Routing MIDI (o
( | Outputs |
Komplete Kontrol Out 1 L 1: Main Qutput L
Komplete Kontrol Qut 1 R 2: Main Qutput R
Komplete Kontrol Out 2 L 3:Qutput 3 L
Komplete Kontrol Qut 2 R 4: Qutput 4 R
Komplete Kontrol Out 3 L 5:5/PDIF Qutput L
Komplete Kontrol Qut 3 R 6: 5/PDIF Qutput R
Komplete Kontrol Out 4 L - not connected -
Komplete Kontrol Out 4 R - not connected -
Komplete Kontrol Out 5 L - not connected -
Komplete Kontrol Qut 5 R - not connected -
| @ cancel | | @oOK |

The Routing page of the Audio and MIDI Settings panel (entries may vary on your computer).

Element Description

Outputs In Outputs, you will be presented with a list of the 16 stereo outputs from
KOMPLETE KONTROL: In the right column, you can assign them to the
outputs of your audio interface. Click the fields in the right column to se-
lect the desired outputs via a drop-down menu.

2.6.3  Audio and MIDI Settings — MIDI Page

The MIDI page allows you to set up the MIDI input ports that you want to use with KOM-
PLETE KONTROL.
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F R
Audio and MIDI Settings (|
Audio Routing MIDI (o
[ Inputs | |
Device name Status
5- Komplete Kontrol - 1 On
5- Kemplete Kontrol EXT -1 QOn
5- Komplete Kontrol DAW - 1 On
Koemplete Audio 6 In QOn
| @ cancel | | @oOK |

The MIDI page of the Audio and MIDI Settings panel (entries may vary on your computer).

Element Description

Inputs Clicking Inputs displays a list of all the available MIDI inputs of your sys-
tem. You can activate/deactivate each input by clicking the fields in the
Status column, which displays the current status of the corresponding
port.

2.1  Connecting External MIDI Equipment to KOMPLETE KONTROL S-
SERIES

You can integrate KOMPLETE KONTROL S-SERIES into your MIDI setup.
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The MIDI sockets on the rear panel of the KOMPLETE KONTROL S-SERIES

To connect your external MIDI equipment:

1. Hook it up to the KOMPLETE KONTROL S-SERIES keyboard’s or
socket on the rear panel.

2. |f KOMPLETE KONTROL is running as a stand-alone application, activate the correspond-
ing MIDI input and/or output(s) of your KOMPLETE KONTROL S-SERIES keyboard in the
MIDI page of the Audio and MIDI Settings panel (see 12.6.2, Audio and MIDI Settings —
Routing Page).

3. If KOMPLETE KONTROL is running as a plug-in in a host application, the MIDI configura-
tion is managed by the host (see sections 12.3, Stand-Alone and Plug-in Mode and
12.3.3, Configuring Your Host Application). Please refer to your host documentation to
know how to configure MIDI in your host.

The 5-pin MIDI ports on KOMPLETE KONTROL S-SERIES’ rear panel are only active when
the keyboard is connected via USB to a computer that is running.

2.8  Incoming and Outgoing MIDI

KOMPLETE KONTROL provides you with flexible MIDI remote control and host automation
abilities that can be used in many situations.

2.8.1  Incoming MIDI and Host Automation

KOMPLETE KONTROL and the KOMPLETE instruments you load inside it can be controlled
via MIDI and the host (when KOMPLETE KONTROL is running as a plug-in):
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= Triggering KOMPLETE instruments via MIDI notes: By default, incoming MIDI notes will trig-
ger the loaded KOMPLETE instrument and will also be visually reflected by the
Light Guide. For information on the MIDI settings, see section 12.6.2, Audio and MIDI
Settings — Routing Page.

= Controlling parameters via host automation: You can control both KOMPLETE KONTROL
and your loaded KOMPLETE instruments’ parameters via host automation (when KOM-
PLETE KONTROL is running as a plug-in). This is described in section 12.10, Controlling
Parameters via MIDI and Host Automation.

Receiving MIDI Clock

When you load KOMPLETE KONTROL as a plug-in in a host application, the tempo is automat-
ically synced to host tempo. The tempo display in KOMPLETE KONTROL's header is grayed
out and tempo is adjusted in the host.

2.8.2  Outgoing MIDI and Host Control
You can also send MIDI data from KOMPLETE KONTROL S-SERIES:

= Recording MIDI notes: When KOMPLETE KONTROL is running as a plug-in in a host envi-
ronment, you can record your performance playing the keys of your KOMPLETE KON-
TROL S-SERIES as a MIDI pattern in your host application.

= Controlling the host application: You can control your host application from your KOM-
PLETE KONTROL S-SERIES keyboard by using the and sections.
This is described in section 17.3, Host Control and the Transport Section.

2.8.3  MIDI Mode

Beyond controlling KOMPLETE KONTROL you can also use your KOMPLETE KONTROL S-
SERIES keyboard in MIDI mode to assign and control any parameters you want via MIDI CC
(see section 17.2, MIDI Mode).

For more information about assigning controls via MIDI, please refer to the Controller Editor
Manual available as a PDF file in the Documentation subfolder of the Controller Editor in-
stallation folder on your hard disk
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2.9 Native Map

You do not have to assign KOMPLETE KONTROL's parameters to MIDI messages in order to
control and automate them via MIDI. Instead, KOMPLETE KONTROL has its own proprietary
mapping system called Native Map that allows you to switch your keyboard on, load a KOM-
PLETE instrument in KOMPLETE KONTROL, and get instant access to its parameters via the
knobs, displays, and touch strips on the KOMPLETE KONTROL S-SERIES keyboard.

2.9.1  Automatically Assigning Controls via Native Map

Immediately after you load a KOMPLETE instrument from the Browser, the instrument’s pa-
rameters are automatically mapped to the eight knobs at the center of your KOMPLETE KON-
TROL S-SERIES keyboard and to the two touch strips on the left-hand side. You do not need to
step through any complicated configurations to map software and hardware controls to each
other.

The mapping of each knob is reflected by its corresponding display. The two arrow shaped
page buttons to the left of the knobs let you skip through all parameters of the loaded KOM-
PLETE instrument while automatically mapping them to the eight knobs on your keyboard. The
change in mapping is reflected by the displays, always informing you of the current mapping.
For detailed information, see section 17.5, Control Section.

2.10 Controlling Parameters via MIDI and Host Automation

When you load KOMPLETE KONTROL as a plug-in into your host application, the parameters
of the loaded KOMPLETE instrument that are currently mapped to the knobs and displays on
KOMPLETE KONTROL S-SERIES also become available for automation from your host.

Which KOMPLETE KONTROL Parameters Can Be Automated?

All the parameters available for automation are found in the Perform Panel or in the loaded
KOMPLETE instrument. You cannot automate the controls located in the Browser as they do
not send MIDI and therefore cannot be found by your host application. This means that only
parameters that are assigned to the knobs and displays on your KOMPLETE KONTROL S-SER-
IES via either Native Map or MIDI CC can be automated.

Native Map
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Controlling Parameters via MIDI and Host Automation

For more information about assigning controls via MIDI, please refer to the Controller Editor
documentation in the software installation folder on your hard disk

In turn, you can also use your KOMPLETE KONTROL S-SERIES to control your host applica-
tion. This is described in section 17.3, Host Control and the Transport Section.

2.10.1 Recording Automation

Many DAWs require that you have set transport record to on (see section 17.3.1, Transport
Controls) in order to record automation, while others make use of dedicated automation con-
trols.

For detailed information regarding automation recording in your DAW, refer to the docu-
mentation of your host software.

To record automation data in your host using KOMPLETE KONTROL, you can take the follow-
ing measures:

On/0ff Switches
To change the state of an on/off switch:

» Click the corresponding button with your computer mouse.

Dl AmiSexy

O Scale R

3

Major Standard

or:

» Turn the knob on your KOMPLETE KONTROL S-SERIES keyboard currently assigned to
the corresponding parameter.

Drop-Down Menus

To select another entry from a drop-down menu:

KOMPLETE KONTROL - Manual - 51



Basic Concepts

Controlling Parameters via MIDI and Host Automation

» Click the corresponding menu with your computer mouse and select an entry.

D -

O Scale

or:

Am | Sexy

Major Standard

Chromatic

' Major

Minar

%Harmonlc Minar

Major Pantatonic
Minor Pentatonic
Bluas

Japanase

Freygish

Gypsy

Flamenco

Altered

Whole Tone
Half-Whole Diminished
Whole-Half Diminishad

» Turn the knob on your KOMPLETE KONTROL S-SERIES keyboard currently assigned to
the corresponding parameter.

Drag Controls

To change the value of a drag control:

» Click and drag the corresponding drag control with your computer mouse.
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or:

» Turn the knob on your KOMPLETE KONTROL S-SERIES keyboard currently assigned to
the corresponding parameter.

2.10.2 Automation IDs

Some DAWSs let you handle automation by using automation IDs that are mapped to specific
parameters of the plug-in. KOMPLETE KONTROL comes with a predefined list of automation
IDs that lets your host application find them automatically.

@ For detailed information regarding automation recording in your DAW, refer to the docu-
mentation of your host software.

Automation IDs for the Perform Panel
The following automation IDs are reserved for KOMPLETE KONTROL's perform parameters:

Automation ID Parameter

000 Reserved for Instance Recognition and Auto-
matic Focus Follow

001 Scale On / Off

002 Scale Root Note

003 Scale Type

004 Scale Key Mode

006 Chord Mode

007 Chord Type

008 Chord Position

009 Chord Voicing

026 Arp On / Off

027 Arp Mode

028 Arp Type

029 Arp Rate
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Automation ID Parameter

030 Arp Sequence
031 Arp Swing
032 Arp Octaves
033 Arp Dynamic
034 Arp Gate

When configuring your own automation IDs, it is important you do not overwrite the
NIKBOO ID, as this is used to recognize the KOMPLETE KONTROL S-SERIES keyboard in
you host.

Automation IDs for KOMPLETE Instruments

The automation IDs 101-1194 are reserved 